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Preface

The Oracle|Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology
Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html) contains the
latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation
folder available on your network from which you can access the Oracle|Agile documentation (PDF)
files.

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later.
This program can be downloaded from the Adobe Web site (http://www.adobe.com).

The Oracle Technology Network (OTN) Web site
(http://www.oracle.com/technology/documentation/agile.html) can be accessed through Help >
Manuals in both the Agile Web Client and the Agile Java Client. If you need additional assistance or
information, please contact support (http://www.oracle.com/agile/support.html)
(http://www.oracle.com/agile/support.html) for assistance.

Note Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please
have the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible, with good
usability, to the disabled community. To that end, our documentation includes features that make
information available to users of assistive technology. This documentation is available in HTML
format, and contains markup to facilitate access by the disabled community. Accessibility standards
will continue to evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be accessible to
all of our customers. For more information, visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/ http://www.oracle.com/accessibility/.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle
Technology Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html)



http://www.oracle.com/technology/documentation/agile.html
http://www.adobe.com/
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http://www.oracle.com/agile/support.html
http://www.oracle.com/agile/support.html
http://www.oracle.com/accessibility/
http://www.oracle.com/accessibility/
http://www.oracle.com/technology/documentation/agile.html

Agile Training Aids

Go to the Oracle University Web page
(http://www.oracle.com/education/chooser/selectcountry _new.html) for more information on Agile
Training offerings.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1
Overview of Agile Database Installation

This chapter includes the following:

m Agile SYSIEM REQUIFEMENLS .....cvivrveeeiiicieiieesiseseiei et st se s sas st ea s s s s 1
= Database Hardware CONfIGUIALION .........cvriiueirireiriieiseeer et 3
5 RAID CONFIGUIALION .....veivriieeieeicisitiee sttt bbbt 5
5 DISK 1/O CONFIGUIALIONS ... ettt bbb bbbt 5

Agile System Requirements

Agile PLM 9.2.2.4 may be deployed in different configurations. The amount of time required to
complete an installation depends on the complexity of your Agile PLM deployment.

Note For installations using a certified localized language, all server components must be
installed on computers running the same localized OS. Clients can be running on the
same localized OS or English OS. For detailed information about using Agile with
international operating systems, refer to the Agile support Web site.

Agile can be distributed over a wide-area network with multiple servers or can be limited to one or
two server computers with several client computers. In the latter case, Agile can usually be installed
within a half day. However, network-based systems are inherently complex, and some installations
require additional time.

Agile recommends installing the Oracle Database Server on a separate computer from the other
Agile components.

It is acceptable to install multiple server components on the same computer if sufficient hardware
resources are available. However, the minimum hardware requirements must be increased based
on the number of server components installed on a single computer.

Operating System Requirements

You should install only supported versions of Agile components that are within the same release.
You should not attempt to install Agile components on unsupported operating systems. Contact
your Agile Solutions Consultant or Agile Technical Support for special requirements.

Operating System Version
Microsoft Windows 2003 R2 (32 and 64-hit)
Solaris (SPARC and x86-64) Versions 9 and 10
Linux Red Hat Enterprise Linux 4 AS (32 and 64-bit)
AIX 5L Version 5.3
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Hardware Requirements

Before you can install Agile server components, you must have at least 1 GB of disk space
available on the drive where the OS is installed, in addition to the minimum disk space requirements
specified in the Capacity Planning Guide.

Important Agile computers and databases should be dedicated to Agile and should not have other
software installed, unless otherwise specified. Do not attempt to include other database
schemas or use the Agile host server as the primary domain controller (PDC) or dynamic
host configuration protocol (DHCP) server.

Note Disk compression must be disabled on the computers where Agile components are
installed..

When choosing a hardware configuration, consider the number of total users, the number of
concurrent users, the size of your database, the number of ECOs processed per day, and overall
activity level. If you have questions about your system, Agile Technical Support or your Agile
Solutions Consultant can give guidance on whether you should choose a small, medium, large, or
extra-large configuration.

It is recommended that the computer on which you are installing Agile components and the Oracle
database have at least two physical drives or two partitions. This allows you to place the operating
system on one drive and use the other drive for Agile or Oracle components.

The tables below provide summary information for minimum hardware requirements based on
database size.

Small database system ( less than 1 GB)

Hardware Windows, Linux and Solaris (SPARC) AlX
Solaris (x86)
CPU Two 1.8 GHz Intel Xeon Two 1.1 GHz UltraSPARC-Illi Two 1.1 GHz POWER4
or equivalent
RAM (GB) 1 1 1
Number and Four 18 GB Four 18 GB Four 18 GB
size of disks
(partitions)

Medium database system (1 GB to 5 GB)

Hardware Windows, Linux Solaris (SPARC) AlX
and Solaris (x86)
CPU Two 1.8 GHz Intel Xeon Two 1.1 GHz UltraSPARC-IIli Two 1.1 GHz POWER4
or equivalent
RAM (GB) 2 2 2
Number and Four 18 GB Four 18 GB Four 18 GB
size of disks
(partitions)
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Large database system (2 GB to 16 GB)

Hardware Windows, Linux Solaris (SPARC) AlX
and Solaris (x86)
CPU Four 1.8 GHz Intel Xeon Four 1.1 GHz UltraSPARC-Illi Four 1.1 GHz POWER4
or equivalent
RAM (GB) 4 4 4
Number and Nine 18 GB Nine 18 GB Nine 18 GB
size of disks
(partitions)

Extra-large database system (5 GB to 38 GB)

Hardware Windows, Linux Solaris (SPARC) AlIX
and Solaris (x86)
CPU Eight 1.8 GHz Intel Xeon | Eight 1.1 GHz UltraSPARC-Illi Eight 1.1 GHz POWER4
or equivalent

RAM (GB) 8 8 8
Number and Twelve 18 GB Twelve 18 GB Twelve 18 GB
size of disks
(partitions)

Agile PLM is certified with Oracle Database Server 9i R2 version 9.2.0.x and 10g R2 version
10.2.0.x. An email system based on SMTP or SMTP gateway is also required. Recommended
database hardware depends on your Agile system configuration.

If you have only single processor computers and anticipate high network traffic, then the database
and Agile Application Server should be installed on two different computers to avoid competition for
resources on a single computer, which would outweigh any advantage gained from reduced
network traffic.

Oracle recommends separate disks for the operating system and database.

Database Hardware Configuration

Agile uses four database configurations (A through D), as shown in the following table. In addition,
The previous tables provide the minimum hardware configuration based on the database sizing
model. Each database configuration provides necessary hardware resources to support the Agile
database sizing model.

Taking into account the hardware requirements specified in the following table, each configuration is
intended for a specific database sizing model. The minimum hardware requirements should be
followed to satisfy the Agile database installation. To increase the scalability and concurrency for
any configuration, provide additional CPUs, RAM, and disk space.

= Configuration A provides the initial hardware resources for implementing the small database
sizing model.
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o Configuration B provides the minimum hardware resources for implementing the medium
(regular) database sizing model.

o Configuration C provides the minimum hardware resources for implementing the large

database sizing model.

@ Configuration D provides the minimum hardware resources for implementing the extra-large

database sizing model.

Agile PLM Database Sizing Matrix

Agile 0S Logged Database Server Hardware
DB Platform | In Peak-
Config- time
uration Active
Users
C R |D| C R D| C R D C R D
P A I[P A I P A I P A I
U M [S]| U M S| U M S U M S
K K K K
S S S S
D Solaris/ 1000 8 8 9| 12 | 12 9| 16 | 16 12 24 24 15
Windows/ GB GB GB GB
Linux/AIX
C Solaris/ 500 4 4 4| 8 8 9| 8 8 1 12 12 12
Windows/ B B 8 cB
Linux/AIX
B Solaris/ 250 4 12 41 8 4 41 4 4 9 Extra Large
Windows/ GB GB B
Linux/AIX
A Solaris/ 100 2 |1 412 2 4 | Large
Windows/ B cB
Linux/AIX
Demo Windows/ | 1 1 5 1 [ Medium
Linux/AIX B
Database Sizing Model Small

Depending on the database sizing and configuration model you follow, the database could
potentially support the following:

o Small database model

Configuration A supports up to 100 concurrent users
Configuration B supports up to 250 concurrent users
Configuration C supports up to 500 concurrent users
Configuration D supports up to 1,000 concurrent users

@ Medium (regular) database model

Page - 4
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* Configuration A supports up to 100 concurrent users
* Configuration B supports up to 250 concurrent users
* Configuration C supports up to 500 concurrent users
* Configuration D supports up to 1,000 concurrent users

= Large database model
* Configuration B supports up to 250 concurrent users
*  Configuration C supports up to 500 concurrent users
® Configuration D supports up to 1,000 concurrent users

o Extra-large database model
* Configuration C supports up to 500 concurrent users
* Configuration D supports up to 1,000 concurrent users

RAID Configuration

RAID 1 mirroring is recommended because of its increased tolerance for hardware fault and
minimal impact on write speed. RAID 0 is recommended for its potential to improve disk read/write
performance.

Although the following section refers to one-disk, four-disk, nine-disk, and twelve-disk
configurations, a RAID 1 configuration may double the number of disks required. It should also be
noted that a combination of RAID 0 and RAID 1 (for example, RAID 10) is often the best
configuration. In fact, such a hardware configuration normally requires an external disk storage
enclosure.

RAID 5 is not recommended as a storage configuration for the Database Server transaction logs.
Instead, choose a storage configuration with mirroring and striping that does not adversely affect
write speed.

Disk 1/0 Configurations

While the proper sizing of extents minimizes dynamic extensions in the same segments, disk 1/0
contention within the same logical tablespace or physical data file can also be harmful.

You can improve disk 1/0 performance for multiple disk configurations by spreading the I/O burden
across multiple disk devices. The following sections describe the use of multiple disks for the Oracle
database server. It is always advisable to use more disks.

There are eight tablespaces in the Agile PLM database configuration: AGILE_DATAL,
AGILE_DATAZ2, AGILE_DATAS, and AGILE_DATAA4 for storage of Agile tables, and AGILE_INDX1,
AGILE_INDX2, AGILE_INDX3, and AGILE_INDX4 for storage of Agile indexes.

Note There is an additional tablespace, SYSAUX, defined with Oracle 10g. If you are using an
Oracle 10g database, add the SYSAUX tablespace to the same drive as the SYSTEM
tablespace.
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Disks Disks Drive/ | Oracle_Home Tablespaces Redo Control
(no RAID) (RAID 1) | Mount Logfiles files
Point
Disk 0 Disk 0/1 Dor Oracle_Home SYSTEM LOG1 Control

fuol TOOLS LOG?2 file01
UNDO L0G3 contol
TEMP LOG4 Control
USERS file03
INDX
AGILE_DATA1
AGILE_DATA2
AGILE_DATA3
AGILE_DATA4
AGILE_INDX1
AGILE_INDX2
AGILE_INDX3
AGILE_INDX4

One-Disk

A one-disk configuration is best for a demonstration, preproduction, and testing environment. This
configuration can produce the highest disk 1/O contention. In addition, as both usage and database
size increase, performance significantly declines. The one-disk configuration is intended for demo
database applications only, and the configuration can be implemented as shown.

There is no beneficial gain from OFA for the one-disk configuration from the perspective of disk 1/0

contention.

Four-Disk Configuration

A four-disk configuration is best for an enterprise-level implementation of Agile. A four-disk

configuration spreads the various data files, control files, and redo log files across multiple disk

devices.

First of all, the three control files can be mirrored onto three different disks for best recovery

protection.

Second, all potential /O demand-intensive data files can be distributed onto their own separate
disk. Redo log files are partially isolated from the rest of the data files, as the log files can cause
significant I/O contention during transactions if they are sharing disks with other data files. The
UNDO data file is separated from the schema data files and log files as well, so I/O contention
during import and upgrade can be minimized.

Page - 6
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Third, the Agile schema tablespaces can be isolated from the rest of the SYSTEM, TEMP, TOOLS,
and UNDO data files.

Disks Disks Drive/ Oracle_Home Tablespaces Redo Control
(no (RAID 1) Mount Logfiles files
RAID) Point
Disk 0 Disk 0/1 D or /u01 Oracle_Home SYSTEM/TOOL/UNDO Control
file01
Disk 1 Disk 2/3 E or /u02 TEMP/USERS/INDX Archive Control
log file file02
Disk 2 Disk 4/5 F or /u03 AGILE_INDX1 Control
AGILE_INDX2 I?_’/Cz)lGUZ/ file03
AGILE_INDX3
AGILE_INDX4
Disk 3 Disk 6/7 G or /u04 AGILE_DATAl
AGILE_DATA2
AGILE_DATA3
AGILE_DATA4

The four-disk configuration shown is recommended. For production database sites, the four-disk
configuration represents the minimum requirements for an OFA implementation and provides the
minimum hardware configuration for performance tuning.

Nine-Disk Configuration

In addition to the advantages associated with a four-disk configuration, a nine-disk configuration
supports an enterprise-level implementation of Agile by further spreading various data files and redo
log files across multiple disk devices.

Application schema can obtain additional performance gains in terms of I/O load spread by further
separating the AGILE_DATA1L, AGILE_DATA2, AGILE_DATA3, AGILE_DATA4 and AGILE_INDX1,
AGILE_INDX2, AGILE_INDX3, AGILE_INDX4 data files because of potential /O contention
between the AGILE_DATA data files and AGILE_INDX data files. For supporting a full text search
content index, a complete separation of potential large datafiles in its own disk spindle should help
I/O contention as physical disk 1/O is inevitable, due to the increasing amount of data, as shown in
the following table.

Disks Disks Drive/Mou | Oracle Home | Tablespaces Redo Control
(no (RAID 1) nt Point Logfiles files
RAID)
Disk 0 Disk 0/1 Cor/u0l Oracle_Home SYSTEM/TOO
L/UNDO
Disk 1 Disk 2/3 D or /u02 TEMP/USERS Control file01
INDX
Disk 2 Disk 4/5 E or /u03 LOG 1/2/3/4 | Control file02
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Disks Disks Drive/Mou | Oracle Home | Tablespaces Redo Control
(no (RAID 1) nt Point Logfiles files
RAID)
Disk 3 Disk 6/7 F or /u04 Archive log Control file03
file
Disk 4 Disk 8/9 G or /lu05 AGILE_DATAl
AGILE_INDX2
Disk 5 Disk H or /u06 AGILE_DATA2
1011 AGILE_INDX3
Disk 6 Disk | or lu07 AGILE_DATA3
12113 AGILE_INDX1
Disk 7 Disk Jor/u08 AGILE_DATA4
14/15
Disk 8 Disk K or /u09 AGILE_INDX4
16/17

Twelve-Disk Configuration

Further separating the AGILE_DATA and AGILE_INDX tablespaces, twelve-disk configurations can
be implemented as shown. This results in completely independent spindles for AGILE_DATAL,
AGILE_DATA2, AGILE_DATAS3, AGILE_DATA4 and AGILE_INDX1, AGILE_INDX2,
AGILE_INDX3, AGILE_INDX4.

Disks Disks Drives/ Oracle Tablespaces Redo Control files
(no (RAID 1) Mount Home Logfiles
RAID) Points
Disk 0 Disk 0/1 Cor/u0l Oracle_Home
Disk 1 Disk 2/3 D or /u02 SYSTEM/TOOL/ Control file01
UNDOI/TEMPI/IN
DX
Disk 2 Disk 4/5 E or /u03 LOG Control file02
1/2/3/4
Disk 3 Disk 6/7 F or /u04 USERS Archive Control file03
logfile
Disk 4 Disk 8/9 G or /lu05 AGILE_DATAl
Disk 5 Disk 10/11 H or /u06 AGILE_DATA2
Disk 6 Disk 12/13 | or fu07 AGILE_DATA3
Disk 7 Disk 14/15 Jor /u08 AGILE_DATA4
Disk 8 Disk 16/17 K or /u09 AGILE_INDX1
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Disks Disks Drives/ Oracle Tablespaces Redo Control files
(no (RAID 1) Mount Home Logfiles

RAID) Points

Disk 9 Disk 18/19 L or /u10 AGILE_INDX2

Disk 10 Disk 20/21 M or full AGILE_INDX3

Disk 11 Disk 22/23 N or /ul2 AGILE_INDX4

Page - 9






Chapter 2
Installing Oracle Database Server

This chapter includes the following:

= Obtaining Software from Oracle E-AElIVEIY ..ot sees 11
= 0racle SOUCE DOCUMENTALION. ........vevrrerieeieieisereieireretsesesees et ebs b es et s st b s s et en s 12
= Before Installing Oracle Database Server 0n WINAOWS...........covvriennieniesesns s sessesessesssees 12
= For Servers Configured WIth DHCP ..ottt 14

Before you install the Agile database, you must install the Oracle Database Server. You can
download the Oracle Database Server Installer from the Oracle distribution location (Oracle E-
Delivery (http://edelivery.oracle.com) or Oracle Technology Network (OTN) Web site
(http://www.oracle.com/technology/documentation/agile.html) ). Download instructions for each
Oracle version/operating system are provided on the download page.

Note For Oracle Database Server 10g R2, after you install the database server software, you
must install the companion products into your 10g R2 ORACLE_HOME from the
companion CD (also available from the sites listed above). The companion products
include some files required to create the Agile schema successfully.

Note Make sure you select the database binaries that are compatible with the hardware you are
using.

For detailed instructions on how to install Oracle 9i R2 or Oracle 10g R2, refer to the appropriate
Installation Guides listed in Oracle Source Documentation on page 12.

Obtaining Software from Oracle E-delivery

Oracle products are distributed as Media Packs on Oracle E-Delivery (http://edelivery.oracle.com).
A Media Pack is an electronic version of the software. Refer to the Media Pack description or the list
of products that you purchased on your Oracle Ordering Document. Then, view the Quick Install
Guide License List to help you decide which Product Pack you need to select in order to search for
the appropriate Media Pack(s) to download. Prior to downloading, verify that the product you are
looking for is in the License and Options section of the E-Pack README. Oracle recommends that
you print the README for reference.

There will be an itemized part list within each of the packs and you will need to download all items in
order to have the complete download for the desired Oracle Agile release.

All Oracle E-Delivery files have been archived using Info-ZIP's highly portable Zip utility. After
downloading one or more of the archives, you will need the UnZip utility or the WinZip utility to
extract the files. You must unzip the archive on the platform for which it was intended. Verify that
the file size of your downloaded file matches the file size displayed on E-Delivery. Unzip each Zip
file to its own temporary directory.

Agile Product Lifecycle Management Page - 11
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Oracle Source Documentation

Before you begin, it is important to be familiar with all the information about installing the Oracle
database on UNIX systems, and with the Optimal Flexible Architecture (OFA) reference material for
administrators. See the following Oracle documents:

u]

Oracle 9i Installation Guide Release 2 (9.2.0.1.0) for UNIX Systems: AlX-Based Systems,
Compagq Tru64 UNIX, HP 9000 Series HP-UX, Linux Intel, and Sun Solaris.

Oracle 9i Administrator's Reference Release 2 (9.2.0.1.0) for UNIX Systems: AlX-Based
Systems, Compaqg Tru64 UNIX, HP 9000 Series HP-UX, Linux Intel, and Sun Solaris in
Appendix G: “Optimal Flexible Architecture.”

These documents are available on the Oracle Technology Network at
http://otn.oracle.com/documentation/oracle9i.html
(http://otn.oracle.com/documentation/oracle9i.html).

Oracle 10g Installation Guide Release 2 (10.2) for UNIX Systems: AlX-Based Systems, hp HP-
UX PA-RISC (64-bit), hp Tru64 UNIX, Linux x86, and Solaris Operating System (SPARC)

Oracle Database Administrator’s Guide 10g Release 2 (10.2)

These documents are available on the Oracle Technology Network at
http://www.oracle.com/technology/documentation/database10gR2.html
(http://www.oracle.com/technology/documentation/database10gR2.html).

Note Agile has made every attempt to be OFA-compliant. Any deviation from OFA
guidelines are noted.

Before Installing Oracle Database Server on Windows

Before installing Oracle, you must:

m]

u]

Verify that Windows has been configured correctly.

Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and convert
the file system if necessary. See Checking the Windows File System on page 13 for directions.

Determine the name of the Windows computer where Oracle is to be installed.

Note It is recommended that the computer on which you are installing the Oracle
database have at least two physical drives or two partitions. This allows you to
place the operating system on the C drive and use the D drive for Oracle
components. The examples in this chapter use a C and D drive.

Be sure that you have Administrator privileges within Windows on the computers where you are
installing Oracle and Agile PLM.

Disable disk compression, if you are using it.

Disable virus protection, if you are using it. Components used in the installer can be falsely
identified as being infected and lock up the installation. You can turn the virus protection on
after the installation is complete.
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The following sections provide more information about these procedures.

Network Check

Before proceeding, it is important to confirm two settings to prevent difficulties from occurring.

Confirming Computer Name and Hostname

The computer where Oracle is installed must use the same value as both its computer name and its
DNS hostname. The following procedures can be used to identify the current values.

To determine the computer name for Windows:
1. Right-click the My Computer icon on the desktop, and choose Properties in the shortcut menu.
2. Inthe System Properties dialog box, click the Computer Name tab.

3. Note the name listed in the Full Computer Name field.

Note Windows uses the same name for the computer name and DNS hostnhame.

Confirming the Server Date

It is important to adjust the date and time of the computer. The date and time need to be correct
when you work with your production data.

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure to
verify the Time Zone setting, too.

Caution If you change the date or time after Agile PLM has been installed and started, you need to
stop and restart the application server immediately after the change.

Checking the Windows File System

Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File
Allocation Table), as NTFS is more robust.

To determine the file system type:

1. Check the file system used on the computer. Choose Start > Administrative Tools > Computer
Management. Under Computer Management in the left pane, expand Storage and select Disk
Management.

The Disk Administration windows opens.

There must be at least two partitions or hard drives. If your computer uses NTFS, proceed with
the Oracle installation. If your computer uses a FAT or FAT32 file system, Agile recommends
converting it to NTFS before proceeding.

Important Converting the file system deletes all current files on the drive. Backup all necessary files
before converting the file system to NTFS.

2. Right-click on the drive you want to reformat and choose Format in the shortcut menu.

3. Inthe File System field, change the file system type to NTFS.
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4. Click Start.

The process takes several minutes. On completion, restart the system. You can proceed with the
Oracle installation.

For Servers Configured with DHCP

If your server is configured with DHCP (Dynamic Host Configuration Protocol), there is a known
issue with the Oracle 10g R2 installation. The installation fails and a warning message displays.

There are two possible solutions:

@ Copy the Oracle 10g R2 installation software to your local disk and perform an off-network
installation.

= Install the Microsoft Loopback adapter on the DHCP server, then add one entry to the hosts
file.

To install the Microsoft Loopback adapter:

1. Click Start > Control Panel > Add/Remove Hardware.

The Add/Remove Hardware wizard appears.

Click Next.

Choose Yes, | have already connected the hardware, then click Next.
Choose Add a new hardware device, then click Next.

Choose Install the hardware that | manually select from a list, then click Next.
Select Network adapters, then click Next.

In the Manufacturers list, select Microsoft.

In the Network Adapter list, select Microsoft Loopback Adapter, then click Next.

© ©® N o g &~ w D

Click Next to install the adapter.
10. Click Finish.

To configure the hosts file:
1. Open the hosts file, located at C:\Windows\System32\drivers\etc.
2. Add the following entry to the hosts file: 10.10.10.10 hostname.domain hostname

For example, if the full machine name of your database server is dbl.agile.agilesoft.com, the
entry in the hosts file would be:

10.10.10.10 dbl.agile.agilesoft.com dbl
3. Save the file.

To configure the loopback IP address on the network:
1. On the database server, right-click the My Network Places icon.
2. Choose Properties to display the Network and Dial-up Connections window.

3. Locate a connection with the device name of Microsoft Loopback Adapter. This connection is
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usually Local Area Connection 2.
Right-click this connection icon.
Choose Properties to display the Local Area Connection 2 Properties dialog box.

On the General tab, select Internet Protocol (TCP/IP), then click Properties to display the Internet
Protocol (TCP/IP) properties dialog box.

On the General tab, choose Use the following IP Address.
8. Enter the following values:

IP address: 10.10.10.10

Subnet mask: 255.255.255.0
9. Click OK.
10. Click Close.

On completion, restart the system. You can proceed with the Oracle installation.
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Chapter 3
Installing the Agile Database on Windows

This chapter includes the following:

INSEANALION NOLES ..o 17
Using the Agile Database Configuration ULIlItY ...........c.coeeriirinn e 18
Adding and Configuring the LISTENET ...........veriereereeeieis e 19
Configuring Oracle Enterprise Manager (OPtONAL) ........co et 21

To install the Agile database on Windows:

1.
2.

Note

Log in with local Administrator permissions.

Download the appropriate Agile PLM media pack for your operating system from Oracle E-
Delivery (http://edelivery.oracle.com).

Extract the contents of the media pack and navigate to the DB folder under Disk1. This folder
contains subfolders for different Oracle versions.

Open the folder for the Oracle version you have installed (Oracle 9i or Oracle 10g). DB
installers for all platforms are delivered with the Diskl folder, regardless of the operating system
on which you have chosen to install Agile PLM.

Double-click the agile9224db_<oracle version>.exe file to start the installation on Windows.

The Agile Database Configuration Utility appears. Follow the instructions in Using the Agile
Database Configuration Utility (on page 18) to configure the database.

Unless specified otherwise, all references to Windows specifically require Windows 2003
with Service Pack 2. Service Packs are available on Microsoft's Web site,
www.microsoft.com

Installation Notes

For best results, as you install:

u]

Follow directions in the order in which they are given. Do not attempt to install any components
out of sequence.

Oracle passwords are not case-sensitive. Agile passwords are case-sensitive. All other text
entries, such as schema names and folder names, are not case-sensitive. To avoid confusion,
all passwords and text entries in this guide appear in lowercase and should be typed as shown.

When prompted for a hostname, type the fully qualified name for the host, not the short name.
For example, if a host is named dbo, type dbo.agile.com, not dbo.
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Using the Agile Database Configuration Utility

The Agile Database Configuration Utility creates and configures the database used by Agile. This
utility appears when you double-click the database installer executable file.

Note

The installer creates and configures an Agile database using the default values.

Drop-down lists that allow disk selection show the available disk space. If the space is a hegative
value, you must select another drive.

Important If you change a default value, you must click in the field to ensure that the change is

activated.

To configure the database:

1.

Note

6.

In the Destination Location dialog box of the Database Configuration Utility, accept the default
location, Agile9Tmp. This is the location where template files are placed during the database
installation. Click Next.

In the Database Size Estimate dialog box, choose a database sizing model. New Agile
customers without an existing database to migrate should accept the default (Small). Click Next.

Note Refer to the Capacity Planning Guide for database sizing information.

In the Oracle Home dialog box, choose the appropriate ORACLE_HOME. This is the location
where the Oracle software was installed. If you have multiple Oracle Homes, make sure the
correct Oracle Home is selected in the list before continuing with the Database Configuration
Utility. Click Next.

In the Oracle SID dialog box, accept the default agile9 SID. If you want to change the SID, you
must use an ID that is 4 to 8 characters in length to uniquely identify the Oracle SID. If you
want to use an existing SID, you must remove it before you can re-use it. Click Next.

Note If you only want to generate database scripts (for example, to upgrade an
existing Agile schema), select the Generate database scripts only option. You are
not prompted to change your SID. Follow onscreen directions to generate
scripts.

In the Database Security and Agile User Information dialog box, accept the following default
values or change passwords as required:

®* Sys Password is oracle

* System Password is manager

* Agile Schema Name is agile

* Agile Schema Password is tartan

Click Next.

Use the tables in the section Disk 1/0 Configurations for guidance while performing steps
6 through 9.

In the Tablespaces dialog box, accept the default, unless you have additional hard drives with
sufficient space available that allow you to distribute the files across multiple hard drives. If you
change the selection to a different drive location, click the letter of the drive to make sure it is
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selected. Click Next.

7. Inthe Redo Log Files and Control Files dialog boxes, accept the default, unless you have
additional hard drives with sufficient space available that allow you to distribute the files across
multiple hard drives. Click Next.

8. If you accept the default location for the files on one drive, a message appears notifying you
about distributing the files across multiple drives (mirroring protection). If this is not an option,
click Next. Otherwise, click Back and reassign files to different hard drives.

9. Inthe Archive Log File dialog box, accept the default, unless you have additional hard drives
with sufficient space available that allow you to store the file on a different hard drive. Click
Next.

10. In the Oracle Language Support dialog box, accept the default character set UTF8. Click Next.

Note For additional information about language support, refer to the Oracle
Globalization Support Guide.

A Command Prompt window displays briefly.
11. You are prompted to install the Agile database. Click Next.
The script runs in a Command Prompt window for a while.

12. When instance creation is complete, a confirmatory message appears. Click OK to complete the
process and exit.

Important Oracle recommends that you change all Oracle database user passwords after you have
created the Agile database. It is recommended to change these passwords periodically for
security purposes.

Agile supports Full Text Search (FTS). FTS is a feature enabled through Oracle Text. Because of
this feature, there is a fixed account, CTXSYS, referenced by some objects in the Agile schema.
For security purposes, you can change the CTXSYS account password from its default, CTXSYS,
to one of your own choice after Agile database creation and configuration.

Adding and Configuring the Listener

If this is the first time Oracle has been installed on the current computer, you need to add and
configure a new database listener.

Note If you are creating a new Agile database on the same machine, you only need to add the
new database to the existing listener.

To add a new Listener on Oracle 9i R2:

1. Start the Oracle Net Configuration Assistant by choosing Start > Programs > Oracle -OraHome92 >
Configuration and Migration Tools > Net Configuration Assistant.

In the Oracle Net Configuration Assistant window, select Listener Configuration. Click Next.
Select Add to add a listener to the database. Click Next.

Accept the default listener name, LISTENER, in the Listener Name dialog box. Click Next.
Accept TCP as the Selected Protocol. Click Next.

Accept the standard port of 1521. Click Next.

o g~ w N
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7. Select No when asked to configure another listener. Click Next.
8. The Listener configuration is complete. Click Next.

9. Click Finish to close the Oracle Net Configuration Assistant window.

To configure the new Listener on Oracle 9i R2:

1. Start the Oracle Net Manager by choosing Start > All Programs > Oracle
- OraHome92 > Configuration and Migration Tools > Net Manager.

In the Oracle Net Manager window, double-click the Local folder and select the Listeners folder.
Click the name of the newly created listener, LISTENER.

Select Database Services in the Listening Locations drop-down list.

Click Add Database.

In the dialog box that appears, make the following changes:
®  Global Database Name: agile9

®  Oracle Home Directory: oracle_home

® SID: agile9

Note If you used a different global database name or different home directory during
the database installation, change the information as appropriate.

5. Choose File > Save Network Configuration to save your changes.

To add and configure a new Listener on Oracle 10g R2:

1. Start the Oracle Net Manager by choosing Start > All Programs > Oracle
- OraDb10g_homel > Configuration and Migration Tools > Net Manager.

2. Inthe Oracle Net Manager window, double-click the Local folder and select the Listeners folder.

3. Click Create il in the toolbar to add a listener.
The Choose Listener Name dialog box appears.
Click OK.

Select Database Services in the Listening Locations drop-down list.
a. Click Add Database.

In the dialog box that appears, make the following changes:
®  Global Database Name: agile9

®  Oracle Home Directory: oracle_home

* SID: agile9

Note If you used a different global database name or different home directory during
the database installation, change the information as appropriate.

6. Choose File > Save Network Configuration to save your changes.

Open a Command Prompt window and type Isnrctl reload to restart the database listener.
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Configuring Oracle Enterprise Manager (Optional)

In Oracle 10g R2, you can use Database Control to perform many database administration and
management tasks including SQL performance tuning.

To configure the Oracle network connection:

1.

10.
11.
12.
13.

Choose Start > All Programs > Oracle - OraDb10g-homel > Configuration and Migration Tools >
Database Configuration Assistant.

The Welcome screen appears.

Click Next.

Choose Configure Database Options on the Operations page. Click Next.
The Database page appears

Select the agile9 database you just created. Click Next.

The Management Options page appears.

Check Configure the Database with Enterprise Manager. Click Next.

The Database Content page appears.

Accept the defaults. Click Next.

The Database Credentials page appears.

Enter a password for the DBSNMP and SYSMAN users. Click Next.
The Connection Mode page appears.

Select Dedicated Server Mode. Click Finish.

Click OK for confirmation. Database configuration begins.

When configuration completes, the Database Control URL displays. Make a note of this URL
because it is used to log in to the database.

Click OK to close the Database Configuration Assistant.
Open a web browser and enter the Database Control URL.
Type the User Name and Password of the Agile database. Click Login.

Click I agree to accept the license agreement and display the Database Control page.

You have finished installing and configuring the Agile PLM database.
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Installing the Agile Database on UNIX

This chapter includes the following:
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Overview

This chapter provides information for installing Oracle and creating the Agile database on Sun
Solaris, Red Hat Enterprise Linux 4, or IBM AIX. Before you begin, make sure that you have
reviewed all relevant Oracle documentation and ensured the computer meets the minimum system
requirements.

Important For best results, start with a clean system (no previous installations of Oracle).

The installation process consists of the following major steps:

= Preparing an installation environment.

o Installing Oracle 9i Release 2 or Oracle 10g Release 2.

o Running the Agile database scripts to create the Agile database.

= Configuring Oracle network connectivity and setting additional Oracle functionality.

System Requirements

Before installing Oracle, ensure that your system configuration meets the minimum hardware
requirements. If you are using a standalone system or hosting multiple instances, consider using
the recommended hardware requirements for the specific environment to ensure acceptable
performance. For information on specific system requirements, see the Capacity Planning Guide.

It is suggested that a system administrator and Oracle database administrator are available to
monitor system activity and determine resource requirements.

Preparing the Host Computer

This section describes how to prepare the installation environment on UNIX, such as creating the
necessary groups and user accounts.

Preparation of the installation environment involves the following:

o Creating the Oracle user account
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= Copying the Agile database utilities
= Modifying system kernel parameters (for Solaris only)

o Setting up Oracle environment variables

Note The term Oracle user is used in this document only as an example. The username need
not be Oracle.

To create the Oracle user account:
1. Log in to the system as root.
2. Create a home directory for the Oracle user:
# mkdir -p /nome/oracle [Enter]
3. Create the Unix group “dba”:
# groupadd dba [Enter]
4. Create the Oracle user:
# useradd -d /home/oracle -s /bin/sh -g dba oracle [Enter]
where:
/home/oracle is the Oracle user home directory
/bin/sh is the Oracle user login shell
dba is the primary group for the Oracle user
5. Set the Oracle user password, and change the Oracle home file ownership:
# passwd oracle [Enter]
Enter password:
# chown oracle:dba /home/oracle [Enter]
6. Create the Oracle installation directory:
# mkdir -p /u01/apploracle [Enter]

# chown oracle:dba /u0l/app/oracle [Enter]
You must now copy the Agile database scripts.

To copy the Agile database utilities:

1. Change to the Oracle user, and create a temporary directory named “agile9224db:”
# su - oracle [Enter]
$ mkdir /home/oracle/agile9224db [Enter]

2. Download the appropriate Agile PLM media pack for your operating system from Oracle E-
Delivery (http://edelivery.oracle.com) to the agile9224db directory.

3. Change to the agile9224db directory, and extract the files from the agile9224db_<Oracle
version>.tar.gz file:

$ cd /home/oracle/agile9224db [Enter]
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$ gunzip -c agile9224db_<Oracle version>.tar.gz|tar xvf - [Enter]

The agile9224db_<Oracle version>.tar file contains the following files:

* agile9.sh — Bourne shell script for creating the database instance and schema

* agile9db.sh — Bourne shell script for generating the database maintenance scripts only
* profile.txt — oracle user .profile template

* system.txt — system kernel parameters

* dbora — setup for the database automatic shutdown and startup

* agile9schema.dmp — schema dump file

* Readme.txt — readme file

For Solaris systems only, you must now modify system kernel parameters, as described below.

To modify the system kernel parameters:

1.

Change to the root user, and back up the /etc/system file:
$su- [Enter]
# cp letc/system Jetc/system_save [Enter]

Verify the following /etc/system kernel parameters. If the parameters do not exist, go to the next
step.

set shmsys:shminfo_shmmax=4294967295
set shmsys:shminfo_shmmin=1

set shmsys:shminfo_shmmni=100

set shmsys:shminfo_shmseg=10

set semsys:seminfo_semmns=1024

set semsys:seminfo_semmni=100

set semsys:seminfo_semms|=500

set semsys:seminfo_semopm=100

set semsys:seminfo_semvmx=32767

set noexec_user_stack=1 (Note:On Oracle 10g only)

Important If you have been running the host computer as an Oracle database server, you have to

check with your Solaris system administrator before changing these parameters. For
these parameter settings, you can also refer to the Oracle documentation.

Note Reboot the computer if you modify the /etc/system file.

The kernel parameter settings above are stored in the file system.txt included with the Agile
database utilities. You can append system.txt to /etc/system if this is the first time you are
configuring the host computer as the database server.

# cat /home/oracle/agile9224db/system.txt >> /etc/system

Note Use >> to append. If you have accidentally used >, you need to recover the
original /etc/system file by using cp system_save system.

Reboot the system to make the new kernel configuration take effect.
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Note If you do not reboot the system, the kernel may not be reconfigured and the
database creation may fail. You may need to check with your Solaris system
administrator for support.

To set up Oracle environment variables:

1.
2.

Log in to the system as the Oracle user.

Create the environment parameter file .profile to include:
PATH=$PATH:/usr/local/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11
export PATH

ORACLE_HOME=<Location where you installed Oracle Database Server>
export ORACLE_HOME

For example:

(Oracle 91))ORACLE_HOME=/u01/app/oracle/product/9.2.0SE; export ORACLE_HOME
ORACLE_BASE=<Oracle base folder location>; export ORACLE_BASE
For example:

ORACLE_BASE=/u01/app/oracle; export ORACLE_BASE
PATH=$PATH:$ORACLE_HOME/bin; export PATH

ORACLE_SID=agile9; export ORACLE_SID

TNS_ADMIN=/var/opt/oracle; export TNS_ADMIN

Note Setting the TNS_ADMIN parameter is optional.
NLS_LANG=American_America.UTF8; export NLS LANG

The environment variables settings above are stored in the file profile.txt included with the Agile
database utilities. If this is the first time you are configuring the host computer as a database
server, copy the profile.txt file to .profile:

$ cat agile9224db/profile.txt > .profile [Enter]
Set environment variables:

$ . ./.profile [Enter]

Creating the Agile Database

This section describes how to create the default database instance and schema used by Agile using
the Agile database creation utility.

To start the installation:

1.

Log in to the computer as the user you created while preparing the installation environment.
For example, Oracle.

1. If necessary, edit the .profile file to change Oracle SID. By default, Agile uses agile9 as the
Oracle SID:

$ vi .profile [Enter]
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2. Modify the value where ORACLE_SID=agile9 by replacing agile9 with the SID you want to
use.

Important Check the /var/opt/oracle/oratab file and make sure that the specified Oracle SID has not

been used. Specifying an existing Oracle SID can corrupt that database instance.

Note The recommended SID length is 4-8 alpha-numeric characters. (The default
SID 'agile9' is six characters.)

3. Source .profile to make the SID changes take effect:
. lprofile  [Enter]
In a second terminal session, log in to the computer as the root user.

Create a directory named “oradata.”

Note The agile9.sh file uses a placeholder mount point /mpt. You must change /mpt
to match your mount points. For OFA compliance, it is highly recommended
that you create at least four mount points (preferably on four different disks
across multiple controllers) to optimize disk I/O.

For example, if you have mount points at /u01 and /u02, you can create an oradata folder on
each mount point.

# mkdir -p /u0l/oradata
# chown oracle:dba /u01/oradata

In the session where you are logged in as the Oracle user, create a SORACLE_BASE/admin
directory:

$ mkdir -p /u01/app/oracle/admin [Enter]
(Assuming ORACLE_BASE is set to /u01/app/oracle.)

You must now run the agile9.sh script.

5.
6.

Change to the /home/oracle/agile9224db directory.

Modify the agile9.sh script to match the mount points on your computer.

Note Make sure ORACLE_SID matches the one you set for .profile, which should
have taken effect after you ran . ./.profile.

Note The agile9.sh file uses a placeholder mount point /mpt. You must change /mpt
to match your mount points. For OFA compliance, it is highly recommended
that you create at least four mount points (preferably on four different disks
across multiple controllers) to optimize disk I/O. Or use a storage subsystem
with RAID land RAID 0 to distribute disk I/O activity and provide fault
tolerance.

The values in the script that can be modified appear in bold. You should limit your editing only
to these bold values.

Note The following code lists variables in bold that you may want to revise besides
placeholder mount point /mpt.

#!/bin/sh

#
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# Oracle_sid default as agile9

#

ORACLE_SID=agile9 # Oracle SID for the database
AASYSPW=oracle # Oracle sys passwd for the database
AASYSTEMPW=manager # Oracle system passwd for the database
AGILE=agile # Oracle account for AGILE schema
AGILEPW=tartan # Oracle passwd for AGILE

#

# Parameters determine location of datafiles,

# controlfiles and logfiles

#
DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID} SYSTEM tablespace
DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID} TOOLS tablespace

DATABASE_TEMP=/mpt/oradata/${ORACLE_SID}

#

#
DATABASE_UNDO=/mpt/oradata/${ORACLE_SID} # RBS tablespace

# TEMP tablespace

#

DATABASE_USERS=/mpt/oradata/${ORACLE_SID} USERS tablespace
DATABASE_INDX=/mpt/oradata/${ORACLE_SID} # INDX tablespace
DATABASE_AGILE_DATAl=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDX1=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDX2=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDX3=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_DATA4=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDX4=/mpt/oradata/${ORACLE_SID}
DATABASE_LOGFILESl=/mpt/oradata/${ORACLE_SID} # REDOLOG file
DATABASE_LOGFILES2=/mpt/oradata/${ORACLE_SID} # REDOLOG file
DATABASE_LOGFILES3=/mpt/oradata/${ORACLE_SID} # REDOLOG file
DATABASE_LOGFILES4=/mpt/oradata/${ORACLE_SID} # REDOLOG file
DATABASE_CONTROLl=/mpt/oradata/${ORACLE_SID} # CONTROL file
#
#

DATABASE_CONTROL2=/mpt/oradata/${ORACLE_SID} CONTROL file

w N R Ww N

DATABASE_CONTROL3=/mpt/oradata/${ORACLE_SID} CONTROL file
DATABASE_ARCHIVE=/mpt/oradata/${ORACLE_SID}/arch #ARCHIVELOGS
#

# Parameters determine character set used

#

Page - 28 Agile Product Lifecycle Management



Chapter 4

CHARACTER_SET=UTF8

NATIONAL_CHARACTER_SET=UTFS8

Run the agile9.sh script from the current directory:

$ chmod u+x agile9.sh

$ /agile9.sh [Enter]

You are prompted about the database size that you want to install.

You should use the regular database size unless you have consulted with an Agile Solutions
Consultant or database administrator to ensure that the computer meets the minimum
requirements for the specified database size.

Note If you are unable to create files, make sure that all Oracle environment
variables are set correctly and that the 'oracle’ user has full (read, write, and
execute) privileges on all directories referenced by agile9.sh.

The script will run for a while.
Oracle recommends that you change all Oracle database user passwords after you have
created the Agile database. It is recommended to change these passwords periodically for
security purposes.

Continue to the next section for post-installation tasks.

Post-Installation Tasks

This section describes how to configure Oracle Net Manager, and set the automatic startup and
shutdown features for the database.

Configuring the listener.ora File

If you are upgrading your Agile database on the same machine, you only need to add the new
database to the existing listener.

To configure the listener.ora file:

Start Net Manager:

$ netmgr &

Within the Local folder, open the Listeners folder and select LISTENER.

1. Check to see if the following settings appear in one of the Address tabs:
=  Protocol: TCP/IP

=  Host: the host computer where the Oracle database is installed
=  Port: 1521

2. If the information does not appear, click Add Address. A new Address tab appears.
3. Type these settings:
=  Protocol: TCP/IP

= Host: the host computer where the Oracle database is installed
= Port: 1521
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4. Select Database Service in the Listener Location drop-down list.
Click Add Database.

6. Inthe dialog box that appears, make the following changes:
= Global Database Name: agile9
= QOracle Home Directory: Oracle_Home
= SID: agile9
3. Choose File > Save Network Configuration to save your changes.

4. Close Net Manager.

Configuring the tnsnames.ora File (Optional)

1. Inthe Oracle Net Manager window, double-click the Local folder and select the Service Naming
folder.

2. Click Create il in the toolbar to add a service name.
The Net Service Name Wizard starts.

3. Inthe Net Service Name field, type the name of the computer where the Oracle database is
located (usually the current computer). Click Next.

You are prompted to select a network protocol. Select TCP/IP (Internet Protocol) and click Next.

Type the name of the computer where Oracle is located in the Hostname field (the same name
you typed in step 3). Accept 1521 as the default port number. Click Next.

6. Select Oracle8i or later as the service name, and type agile9 in the field. Click Next.
Click Test to test the service.
The test initially fails because the default uses the incorrect login.
Click Change Login to reset the username and password.
9. Type agile in the Username field and tartan in the Password field. Click OK.
10. Click Test. You should now see a message indicating that the test was successful.
11. Click Close.
12. Click Finish to exit the Net Service Name Wizard.

13. From the Net Manager menu, choose File > Save Network Configuration to save the service hame.

This completes the installation and configuration for Oracle on Solaris.

Setting Up Oracle Net Manager (Optional)

To set up Oracle Net Manager:

If you use the TNS_ADMIN environment variable to specify the location of Oracle Network Services
configuration files (such as tnsnames.ora), move the files located in the
$ORACLE_HOME/network/admin directory to the directory specified by TNS_ADMIN.

1. Log in as root and change the ownership of the /var/opt/oracle directory:
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# chown -R oracle:dba /var/opt/oracle [Enter]

2. Switch to the Oracle user, and change to the $ORACLE_HOME/network/admin directory:
# su - oracle [Enter]
$ cd SORACLE_HOME/network/admin [Enter]

3. Move all the files to the directory defined by environment parameter TNS_ADMIN, which is
Ivar/opt/oracle:

$ mv * /var/opt/oracle [Enter]

Setting Up Automatic Shutdown and Startup for the Database (Optional)

To set up the Oracle database to automatically shut down and start up when the host computer starts up and
shuts down:

1. Log in the system as root.
2. Create a file named “dbora” in the /etc/init.d directory:

# cat /Thome/oracle/agile9224db/dbora > /etc/init.d/dbora [Enter]
3. Link to the dbora file:

# In -s /etc/init.d/dbora /etc/rc0.d/K10dbora [Enter]

# In -s /etc/init.d/dbora /etc/rc2.d/S99dbora [Enter]
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Chapter 5

Creating a RAC Database and Schema for
Agile PLM

This chapter includes the following:

= Creating an Oracle 10g R2 RAC Database Instance for Agile PLM.......c.ccocoviernennienscsrsesssrcsessseesnens 33
=  Creating an Agile PLM Schema in an Existing RAC or Standalone Database InStance ........c.ccocovveeevrieennnnn. 35

You can create a Real Application Clusters (RAC) database instance for Agile PLM using the
Oracle Database Configuration Assistant (DBCA), and then create an Agile PLM schema in that
database instance.

Creating an Oracle 10g R2 RAC Database Instance for
Agile PLM

To create a RAC database instance:

1. Start the Oracle Database Configuration Assistant. (From the Start menu, navigate to All
Programs > Oracle — <Oracle Home> > Configuration and Migration Tools, and choose Database
Configuration Assistant). The Database Configuration Assistant : Welcome dialog appears.

Select the Oracle Real Application Clusters database option. Click Next.
In the Operations dialog, select Create a Database. Click Next.
In the Node Selection dialog, select all RAC nodes. Click Next.

In the Database Templates dialog, select Custom Database. Click Next.
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In the Database Identification dialog, enter values for the Global Database Name and SID
Prefix. For example, RAC.WORLD and RAC. Click Next.

7. In the Management Options dialog, click Next to accept the default selections. For more
information on Oracle Enterprise Manager, see related documentation on the Oracle
Technology Network (OTN) Web site
(http://www.oracle.com/technology/documentation/agile.html).

8. Inthe Database Credentials dialog, choose the Use the Same Password for All Accounts option.
You can change the passwords later. Enter a password and confirm it. Click Next.

9. Inthe Storage Options dialog, select your preferred storage option. The storage option that you
have on your system is automatically detected and appears selected. Click Next. Based on your
selection, the Database Configuration Assistant will present further options. Follow onscreen
directions to configure storage details.

10. Next, select the database components you require. In the Database Content dialog, under
Database Components, select the following:

®  Oracle Data Mining
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11.

12.

13.

14.
15.

16.
17.

Oracle Text

Enterprise Manager Repository (Optional)

Click Next.

In the Database Services dialog, to accept the current configuration details, click Next.

Note

At any stage, to change your selections, click Back and navigate to the

appropriate dialog.

In the Initialization Parameters dialog, under Memory, select Custom. Provide desired SGA and

PGA sizes or accept the default. Click Next.

In the Database Storage dialog, select the Tablespaces node. Create the following tablespaces
in the instance.

Note

Review the storage parameters and click Next to accept.

AGILE_DATA1l
AGILE_DATA2
AGILE_DATA3
AGILE_DATA4
AGILE_INDX1
AGILE_INDX2
AGILE_INDX3
AGILE_INDX4

Data files should be sized at least 1GB each with autoextend enabled, and
must be named as listed above. You can store the datafile at any location on
your hard drive. For guidance on sizing, refer to the tables in Disk 1/O

Configurations.

In the Creation Options dialog, Create a Database is the default selection. Click Finish to accept

database creation settings.

In the Summary screen, click OK to start the database creation process.

Once the database creation is complete, a dialog appears with details of the newly created
database instance. Make a note of the information for your records. Within this dialog, click

Password Management and do the following:

1.

Make sure that the CTXSYS account is not locked. If it is locked, log into Oracle as 'sys' or

'system' and execute the SQL command:
alter user ctxsys account unlock;

Set the following account passwords:
= sys/oracle

= system/ manager

= ctxsys/ ctxsys

You can change the passwords after schema creation is complete.

18. Click Exit. The RAC database instance creation is now complete.
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Creating an Agile PLM Schema in an Existing RAC or
Standalone Database Instance

The Oracle database stores data in virtual containers known as schemas. The Agile Database
Configuration Utility creates the database, user account, and schema used by Agile. Additional
schemas are not necessary; however, you can create additional Agile schemas with different user
names if necessary.

Note

You should not use the Oracle Security Manager to create users.

To create a schema in the RAC Database Instance on UNIX:

1.
2.

3.

Run agile9db.sh to generate the Agile PLM 9.2.2.4 schema maintenance scripts.
Log in as the system user and run the following SQL command:
create public synonym DBMS_SHARED POOL for sys.DBMS_SHARED POOL;

Run recreateagile.sh to create the schema.

To create a schema in the RAC Database Instance on Windows:

1.
2.

Run the database installer as described in Installing the Agile Database on Windows.

In the installer screen where you specify the Oracle SID, select the Generate Database Scripts
Only check box. See Step 4 under Using the Agile Database Configuration Utility (on page 18).

Follow onscreen instructions to generate scripts.

Log in as the system user and run the following SQL command:
create public synonym DBMS_SHARED_POOL for sys.DBMS_SHARED_POOL;
Run recreateagile.bat to create the schema.
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Appendix A
Database Management

This Appendix includes the following:

5 DAtADASE MAINIENANCE ........cvcvieiiiiiieectetee ettt b bbb bbb ae s bbb et et e b e e e sttt ebebe e st abebenas 37
m Backing Up the DAtADASE ........ccvrrieerieieiriieisisesesiee sttt as bbbt 38

It is important to protect your Agile data and system files from loss. This section describes basic
backup and recovery strategies and gives specific information about applying them to your Agile
system used with Oracle products.

The instructions in this section are for system and database administrators who need to manage the
Agile database.

Database Maintenance

This section provides database maintenance procedures.

Fine-Tuning Index Settings

Depending on your database server and the fields most frequently searched at your site, you may
speed up searches by using an SQL script to create additional database indexes. If you are
experiencing noticeably slow performance when searching on certain fields, contact Agile Technical
Support to see if index modifications might help. Note that an added index needs to be analyzed
for statistics, otherwise, the cost-based optimizer may not use it.

Monthly Maintenance

Plan for a regular monthly cold backup of your database as a maintenance measure.

Note An export of the Agile database may not be sufficient because a file content index
synchronization is needed after data is imported to the database server.

Checking Database Space Allocation

Checking the tablespace data files in your Oracle database on a monthly basis can help determine
how close your database storage is to maximum capacity. If any or all of the tablespaces are at
least 90 percent, you should do the following:

o Frequently export the agile schema to view the dump file size. You may need to consider
migrating to a larger database sizing model.

@ Increase the disk space allocation for the specific tablespaces. One method for accomplishing
this is to increase the data file size for the corresponding tablespaces, as follows:

1. Check the disk space for the hard drive where the Oracle database is located.
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2. Ifthere is less than 500 MB available, it is recommended that you increase disk space by
adding to or replacing the hard drive.

3. To check the tablespace data files, start the Enterprise Manager Console. The Oracle Enterprise
Manager Login dialog box appears.

Select Launch standalone and click OK.
double-click the Databases folder and the name of the database.
Log in as follows, and then click OK:

Username: system

Password: manager

Service: hostname (remote) or blank (local)

Connect As: normal

Note Type the fully qualified hostname of the computer in the Service field (or Host
String in some cases) if you are not logging in on the same computer where you
have installed Oracle or if you receive a TNS error message.

7. Under Storage > Tablespaces, select System, Temporary, Agile_ DATA1-4, and Agile_INDX1-4 and
determine if the amount of disk space each tablespace is using exceeds 90 percent. Make sure
Agile_INDX4 has enough space for file content index synchronization.

Note If you need to increase the amount of available disk space, double-click the
value in the Size field.

8. The Edit Datafile dialog box appears. Increase the amount of available disk space, and then
click OK.

If possible, you should double the current disk space. If the disk space is not available on the
hard drive, you should consider upgrading your hardware.

Note This is a preventive and proactive measure, but is not required. All Agile
tablespaces automatically extend by 10MB whenever additional disk space is
needed and available.

Dynamic Versus Static IP Addresses

You can use dynamic IP addresses with “long-term lease” assignments, as well as static addresses,
for Oracle systems. For best results, do not change the hostname of computers in the system, and
use static IP addresses.

Backing Up the Database

You should institute routine backups of all servers. Agile recommends backing up entire disks to
save both database and registry data.

Database losses are unfortunate, but they can and do occur. They can result from hardware
failures, natural disasters, fire, power surges, and problems with administration and configuration.
Whatever their cause, your best protection against business disruption and permanent data loss is
an effective backup and recovery plan, applied as automatically as possible.

This chapter introduces several ways to back up and recover data. You will need additional
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information to adequately administer and protect your database. You may need to do a cost/benefit
analysis to determine how often to back up critical data and to justify the labor, hardware, software,
and storage costs involved. The following documents may be helpful:

u]

Oracle9i User-Managed Backup and Recovery Guide or Oracle Database Backup and
Recovery Basics 10g Release 2

Oracle9i Recovery Manager User's Guide

Oracle9i Database Concepts or Oracle Database Concepts 10g Release 2
Legato Storage Manager Administrator's Guide

Note The documents are available at Oracle’s Web site:

http://otn.oracle.com/documentation/oracle9i.html
(http://otn.oracle.com/documentation/oracle9i.html)

http://www.oracle.com/technology/documentation/database10gR2.html
(http://www.oracle.com/technology/documentation/database10gR2.html)

You must be a member of the Oracle Technology Network to have access to the site
(becoming a member requires simply that you register at the site to gain access).

Backup and Recovery Strategy

When you are planning a backup and recovery strategy, you need to consider the following factors:

m]

Database availability

What is the database availability requirement for business operations? Is it required for
7X24X365 availability or only during standard business hours?

According to the availability requirement, different database backup methods can be adopted. If
the database cannot be shut down, a hot online backup is the only choice.

ARCHIVELOG and NOARCHIVELOG mode
A database can run in ARCHIVELOG or NOARCHIVELOG mode.

When the database is in operation, all database changes are recorded in redo log files. If the
database is running in ARCHIVELOG mode, these redo log files are archived in the database
archive log destination and are referred to as archived redo log files. A database running in
ARCHIVELOG mode provides better protection from data loss. It can be recovered up to the
point of failure. To perform a hot backup, a database must be running in ARCHIVELOG mode.

The default configuration for the Agile database is NOARCHIVELOG mode. You can change
the database to ARCHIVELOG mode following the instructions available in the initagile9.ora
file. It is recommended that an Oracle DBA or Oracle support be available.

Data loss tolerance
How much data can you afford to lose due to a database crash?

Can you afford to lose one day or one week’s worth of data in the event of a database crash?
Can you re-enter user data if there is a database failure?
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If your database cannot tolerate data loss due to failure, then a good data protection backup
method needs to be adopted, such as hot or cold backup using ARCHIVELOG mode.

o Recovery time
How much time can you afford to spend recovering a database in the event of a crash?

Different backup methods have different recovery times. Physical methods for backup and
recovery are much faster than logical backups, and backups to disk are much faster than to
tape. Recovery is also much faster from disk than from tape.

@ Technical skills
What are the technical skills of your database or systems administrator?

Some backup methods require more database knowledge than others. Standby databases
require more technical skill than cold or hot backup.

o Hardware or software investment
How much hardware or software investment do you want to put into the system?

Some advanced features, such as high availability, require more of an investment in hardware
and software.

You can determine the safest backup method for your environment based on database
requirements, database running mode, and your recovery scenario (as described in the following
table). However, the final decisions about the backup and recovery strategy you use is beyond the
scope of this chapter. For detailed information to help you make these decisions, see the books
listed on the previous page.

Scenario Backup methods
The database requires 7X24 Hot backup
uptime and cannot be shut down Export

Database must be running in ARCHIVELOG mode

The database is available during Hot backup
regular business hours and canbe | Cold backup
shutdown Export

Database can running in NOARCHIVELOG or

ARCHIVELOG mode
To recover up to the point of Hot backup
failure Cold backup with ARCHIVELOG mode
To recover an individual user or Export
table
For fast recovery Hot backup
Cold backup

Implementing Backup Procedures

For best backup results, follow these guidelines:
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Schedule online backups when there is minimal database access.
Have a fixed schedule for online backups so users can plan for database slowdowns.
Test your backup strategy to see if it is effective; make changes if any area is weak.

Plan to save at least one version back; choose to retain enough versions for your business
needs.

Perform database consistency checks just before export or after import.

Back up the master database before and after it is altered; if you save the original database
creation scripts, you can use the same scripts to recreate it.

For a distributed system, plan on coordinating backup procedures so each site can be backed
up individually without destroying the integrity of the data at other sites.

Oracle recommends that you export and re-import the database on a monthly basis to maintain
optimum performance.

Useful Information for Backup and Maintenance Tools

If you use Oracle tools such as SQL Plus or third-party backup tools, you need to enter information
about the Oracle database installation. The table below lists default data; these names might differ if
custom names were used instead of the defaults.

Oracle Field Default Data Custom Data
Oracle Sys account password oracle
Oracle System account password manager
Oracle Ctxsys account password ctxsys
Oracle database Agile account username agile
Oracle database Agile account password tartan
Oracle database host name Agile server hostname
Oracle database instance agile9

Types of Backups

This section describe the following types of backups:

m]

m]

u]

Registry file backups
System backups
Standby database backups

Standard database backups
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System administrators often perform the first two types of backups, and database administrators
(DBASs) perform the last two types of backups.

The last three types of backups should include backing up the Agile server files located at \\<Agile
installation directory>\Agile9. These are the files needed to run Agile and the attachments to the
Agile database. They should also include backing up the Oracle files located in the
\\oracle\oradata\<instance name> folder.

Third-party backup procedures, such as Cheyenne Software’s ArcServe, are not described in this
chapter. However, if you are using one, see “Useful Information for Backup and Maintenance Tools
(on page 41)” for the default username and other Oracle database information.

Performing System Backups

You typically perform a system backup on a small system. You bring down the entire system,
including all the programs, data files, and log files. Typically, a system backup is run each night.

To perform a system backup, shut down the system, start it up again in single-user or maintenance mode,
then copy system files to tape, as follows:

1. Shut down active applications.

Shut down the relational database.

Stop the Agile Application Server process.

Bring the system back in single-user (maintenance) mode.
Back up all disks to tape with a suitable utility.

Start the Agile Application Server process.

Start the system in multi-user mode.

Restart the database.
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Restart applications as needed.
Using Standby Databases

Typically, a standby database is run on a large system. The standby database feature maintains a
duplicate database of your primary online database at the same location or at a remote site. (Both
the standby database and the primary database must be running on the same hardware platform,
operating system, and Oracle patch release.) A standby database acts as a backup when it resides
locally, and is implemented as part of a database disaster recovery strategy when it resides at a
remote site. The standby database has the following features:

= Itis copied from the primary or current production database onto a system residing locally or
remotely.

= Itis mounted, but not open, and is in constant recovery mode.

@ Redo log files generated from the primary database can be transported to the standby
database, and the standby database can apply these logs to recover the database.

o In the event of a disaster, a standby database can be activated and fully functional as a new
production database.

A standby database takes time to set up and configure. For more information, see the references
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suggested in “Exporting the Database (on page 46)".

Performing Database Backups

Typically, you run a standard database backup daily. Databases backups can be:

= Cold or offline, where the database is shut down before copying database-related files: control
files, data files, redo log files, initial parameter file (initagile9.ora), spfileagile9.ora, and
password file(pwdagile9.ora). A database running in ARCHIVELOG or NOARCHIVELOG mode
can be backed up by a cold backup (NOARCHIVELOG mode permits only cold backups).

= Hot or online, where a backup is performed while the database is open and users are
accessing it. To perform a hot backup, a database must be running in ARCHIVELOG mode.
When performing a hot backup, the database tablespace must first be put in backup mode,
then the datafile can be copied by the operating system. Once the datafile has been copied, the
database tablespace can be placed online again. This allows the database to be backed up
tablespace by tablespace.

= Alogical backup creates logical copies of database objects in a binary export file. Logical
backups use the agile9 database utilities, agile9exp and agile9imp. When performing logical
backups, a database must be open and running.

Note Oracle EXP and IMP utilities do not export the ctxsys account. So, FTS objects
will be recreated during an agile9 import.

For best results, you should timestamp backups and generate scripts to perform them automatically
using the operating system task schedule command.

Performing Cold Backups

Cold backups should be done on all the database-related files, including data files, control files,
redo log files, the initial parameter file (initagile9.ora),the password file (pwdagile9.ora), and the
server parameter file (spfileagile9.ora).

To perform a cold backup on all database-related files:
1. Shut down the database.

2. Use the operating system copy command to copy all of the database data files, the control file,
the initial parameter file, the password file, and the archived redo log file (if the database is
running in ARCHIVELOG mode) to the backup destination.

3. Restart the database.

For details, see the references suggested in “Exporting the Database (on page 46)”.
Performing Hot Backups

Hot backups require a setup procedure, after which a backup is created every day. For instructions,
see the references suggested in Exporting the Database (on page 46).
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Creating the Agile PLM Schema and Importing the Database

Before you import, ensure that you have taken a full backup of your Oracle database or of the Agile
schema, as described in Exporting the Database (on page 46).

Note

If you are prompted for the service name or host string, you must provide the fully
qualified computer name.

To create the Agile schema and import the database on Windows:

1.
2.
3.

Confirm that the schema is valid.
Run the Agile PLM 9.2.2.4 database installer.

In the Oracle SID dialog box, ensure that the Generate database scripts only option is selected as
described in Step 4 of Using the Agile Database Configuration Utility (on page 18). Follow
onscreen prompts to complete script generation.

Next, to ensure that the schema is organized correctly, type the following in a Command
Prompt window:

cd oracle\admin\agile9\create

recreateagile.bat

Note Running this command will drop the existing Agile schema (if any) as well as
any data that it contains.

Check import parameters in the agile9imp.par text file, which contains the following:

file=agile9exp.dmp log=agile9imp.log fromuser=agile touser=agile indexes=n rows=y ignore=y grants=n
constraints=n statistics=n

where:

file is the file to import. The DMP file schema version must match the latest schema
version of agile9.exe.

log is the import log file.

fromuser is the user account in the file that contains the data that will be imported. fromuser
must exist in the DMP file specified by the file.

touser is the user account where the data is being imported. touser must match the current
value of %AGILE%; otherwise, importing the data may cause data corruption.

Note The indexes, rows, ignore, grants, constraints, and statistics parameters specify
other import settings. Do not modify these parameters, and these settings
should only be used when using the agile9imp script. If a standalone imp is
used, do not use these settings.

To import the database and recreate indexes and statistics, type the following:
agile9imp.bat
After the batch file finishes running, type Exit to close the Command Prompt window.

Note For file content index synchronization, call Agile Technical Support.
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To import the Agile schema on UNIX:

1.

o > 0N

10.

11.

12.

13.

Log in as the Oracle user.

Confirm that the database schema is valid.
Confirm that the user account name is new.
Make a backup of the existing database schema.
Change to the oracle user directory:

$cd

Copy agile9db from the agile9224db directory:

$ cp ./agile9224db/agile9db.sh

Edit the agile9db shell script, and find AGILE=agile.
Change agile to the new, unused account hame.
Save and close the file.

Run agile9db:

$ chmod u+x agile9db.sh

$ Jagile9db.sh

You are prompted to choose a database size. Enter R for regular or L for large based on how
you created the database initially.

The script creates several SQL scripts and Bourne shell scripts in the following directory:
$ORACLE_BASE/admin/$ORACLE_SID/create.

When the script finishes running, type the following:

$ cd $ORACLE_BASE/admin/$ORACLE_SID/create

Run recreateagile:

$ chmod u+x recreateagile.sh

$ Irecreateagile.sh

Note Running this command will drop the existing Agile schema (if any) as well as
any data that it contains.

Before importing the database, you can check import parameters in the agileQimp.par text file,
which contains the following parameters:

file=agile9exp.dmp log=agile9imp.log fromuser=agile touser=agile indexes=n rows=y ignore=y grants=n
contraints=n statistics=n
where:

* file — File to import. The DMP file schema version must match the latest schema version
of agile9.sh.

®* log — Import log file.
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* fromuser — User account in file that contains data to import. fromuser must exist in the DMP
file specified.

* touser — User account where the data is being imported. touser must match the current
value of $AGILE. Otherwise, importing may cause data corruption.

Note The indexes, rows, ignore, grants, constraints, and statistics parameters specify
other import settings. Do not modify these parameters, and these settings
should only be used when using the agileSimp script. If a standalone imp is
used, do not use these settings.

14. To import the schema and recreate indexes and statistics, type the following commands:
$ chmod u+x agile9imp.sh
$ Jagile9imp.sh

Note For file content index synchronization, call Agile Technical Support.

Exporting the Database

For maximum data security, you should use a cold backup. You can import the Agile schema DMP
file whenever you need to restore a database or replicate it on another computer with the exception
of file content index synchronization because of its dependence on the file system.

If you are copying or moving the Agile schema to another computer, you need to set up the
computer before importing the Agile schema.

Exporting the Full Oracle Database

When you perform a full export, you export all schemas in the Oracle database.

Note If you are prompted for the service name or host string, you must provide the fully
qualified computer name.

To export the full Oracle database on Windows:

1. Ensure that all system users are logged off. The easiest way to do this is to disconnect the
server from the network.

2. Open a Command Prompt window.
3. Set the character set:
set NLS_LANG=American_America.utf8

4. Type the following text with spaces and a triple set of quotes as indicated (do not press Enter
until you have typed the whole text string):

exp system/manager full=y file="""<drive>:\Agile9Tmp\<exp_filename>.dmp
log="""drive:\Agile9Tmp\<exp_filename>.log”"”

Agile recommends naming the export file expfull.dmp. For example:

o nn nnn

exp system/manager full=y file="""d:\Agile9Tmp\expfull.dmp™"* log="""d:\Agile9Tmp\expfull.log
To export the full Oracle database on UNIX:

1. Ensure that all system users are logged off. The easiest way to do this is to disconnect the
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server from the network.
Enter the following command:

$ exp system/manager full=y file/home/oracle/agile9224db/ <exp_filename>.dmp
log=/home/oracle/agile9224db/<exp_filename>.log

Agile recommends naming the export file expfull.dmp. For example:

exp system/manager full=y file=lhome/oracle/agile9224db/expfull.dmp
log=/home/oracle/agile9224db/expfull.log

The database export takes a while. When it completes, open the log file and see if the export was
successful. If there were problems, call Agile Technical Support.

You can copy the successful export of expfull.dmp to another secure computer as a backup.

Exporting the Agile Schema from Oracle

You can export only the Agile schema. This is much faster than exporting the full database.

Note If you are prompted for the service name or host string, you must provide the
fully qualified computer name.

To export only the Agile schema on Windows:

1.

Ensure that all users are logged off before shutting down the application server.

Note The following commands use the D drive. If you have installed agile9224db or
Oracle on another drive, specify that drive letter.

Open a Command Prompt window, and type the following:
d:
cd \oracle\admin\agile9\create

Before exporting the database, you should check export parameters in the agile9exp.par text
file, which contains the following parameters:

file=agile9exp.dmp log=agile9exp.log owner=agile

where:

* file is the file to export.

* log is the export log file.

® owner is the user account that contains data to export.
To export the database, type the following:

agile9exp.bat

To export only the Agile schema on UNIX:

1.

Ensure that all users are logged off. The easiest way to do this is to disconnect the server from
the network.
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2. Change to the directory where the Agile scripts are located:
$ cd SORACLE_BASE/admin/$ORACLE_SID/create

3. Before exporting the database, you can check parameters for exporting in a text file named
agile9exp.par, which contains the following parameters:

file=agile9exp.dmp log=agile9exp.log owner=agile

where:

* file — File to export.

* log — Export log file.

* owner — User account that contains data to export.
4. To export the database, type the following command:

$ chmod u+x agile9exp.sh

$ Jagile9exp.sh

The database export takes awhile. When it is complete, open the log file and see if the export was
successful. If there were problems, call Agile Technical Support.

You can copy the successful export of expdat.dmp to another secure computer as a backup.

Deleting an Instance and the Database Files

Before creating a new instance, you should delete the existing instance (such as agile9).

1. Make sure the Oracle Listener and Agile9 service are running. (Agile9 is the Oracle service if
your SID is Agile9.)

Start the Database Configuration Assistant.

w

Select Delete a Database, and click Next.

The instance you want to delete (Agile9) should appear in the Available Instances field.
Select the instance.

Type the username (sys) and password (oracle), if necessary.

Click Finish.

N o o s

You are prompted to confirm the deletion, and then a message appears confirming that the
instance has been removed.

8. Confirm that the agile9-related password file, spfile, and init files in the $ORACLE_HOME/dbs
folder on Solaris have been deleted.

9. Confirm that the agile9-related password file, spfile, and init files in the
%ORACLE_HOME\database folder on Windows have been deleted.

Note After dropping a database instance using the Database Configuration
Assistant, the TEMP tablespace must be removed manually.

Database Recovery

In the case of failure, database recovery uses a previous database backup to recreate a database
that is as complete, accurate, and up-to-date as possible. Database recovery depends on the
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database backup method. Two backup methods are standard backup and logical backup.

= For standard backup, including cold and hot backup, database recovery requires the use of the
operating system copy command to restore backed up datafiles.

* If the database is running in NOARCHIVELOG mode, there are no backed up archive log
files. Recovery is to restore a previously backed up data file, control file, initial parameter
file, and password file. No redo log files are applied and no database roll forward is
needed. In this scenario, a database can be recovered up to the last backup.

* If the database is running ARCHIVELOG mode, database recovery is to restore previous
backed up database files up to the last archived log files. When recovering a database,
these archived log files are applied and the database roll forward. In this scenario, a
database can be recovered up to the point of database failure.

= For a logical backup, a database recovery involves importing the database or schema from a
previous export DMP file. For a logical backup, there is no roll forward involved.

Database recovery can be performed by using Oracle Recovery Manager. For more database
recovery information, see the references suggested in Exporting the Database (on page 46).

Using Oracle Recovery Manager

You can use the Oracle Recovery Manager to perform an automatic recovery, restore the full
database, restore a data file, or restore a control file.

The major advantage for Oracle Recovery Manager (RMAN) is that it can perform incremental
database backup and recovery. Incremental backup and recovery is much faster than a full
database backup and recovery, especially for large database systems. RMAN is more complicated
to setup compared with a standard backup.

Running SQL Scripts Against the Agile PLM Schema

Important Before running a script, make sure you have a current backup (export) of your Agile
database. For instructions on exporting (creating a DMP backup of your Agile database),
refer to your Oracle documentation or Help system.

To run an SQL script against an Oracle database on Windows:

1. Create a new directory called "scripts" under the oracle\admin\agile9\create directory. Where agile9
is your Oracle SID.

Copy the SQL script to the scripts folder.
On the computer where Oracle is installed, start SQL Plus in a command prompt window.

Type the login ID and password (the defaults are agile and tartan).

o~ w0

Before running the script, create a spool file to record and contain the results from issuing the
SQL script. At the SQL prompt type:

spool d:\oracle\admin\agile9\create\scripts\filename.Ist
For example: spool d:\oracle\admin\agile9\create\scripts\averifyresults.Ist
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Note The file with the LST extension is any filename that you want to use to identify
the file that will contain these results. It is best and easiest to give the LST file
the same name as the filename that is attached to the SQL file.

For example, if the SQL file to be run is oracle_averify90.sql, then name the spool file
oracle_averify90.Ist. You can also specify a drive or location other than what is shown in the
previous example.

The drive and location specified are where the spool file will be saved.

6. Issue the command to run the SQL script by typing the following at the SQL prompt:
@d:\oracle\admin\agile9\create\scripts\filename.sql
For example: @d:\oracle\admin\agile9\create\scripts\oracle_averify90.sql
Note The @ symbol must be typed directly in front of this command line.
The file with the SQL extension is the name of the specific SQL file to be issued against the
database. Depending on where the SQL file is located on the server, you will also specify the
drive and location, which could be something other than the d:\oracle\admin\agileS\create\scripts
shown in the example.
Notice the process of the script being executed. When it is complete, there will be an indication
of “commit, complete.”
At the SQL prompt, type the following: spool off
Close the SQL Plus window and exit SQL Plus.
Note In some cases where a change is being made to the database, you may need
to stop and restart both Agile services for the change to take effect. If this is
necessary, you will be advised at the time the script is provided. In the case of
issuing scripts that do not make changes to the database scripts (for example,
oracle_averify.sql scripts), restarting the Agile services is not necessary.
9. Locate and open the spool file created in step 4, if necessary.
The file can be opened within an application such as Notepad so that results can be viewed
and printed, if necessary.
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